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CE Mark

 

The CE marking applied to this product symbolises Rank Xerox’s declaration of conformity with the following applicable directives of the European Union as of 
the dates indicated.

January 1, 1996—Council Directive 70/80/CCO amended by Council Directive 93/68/EEO. Approximation of the laws of the member states related to low 
voltage equipment.

January 1, 1996—Council Directive 59/336/EEC. Approximation of the laws of the member states related to electromagnetic compatibility.

A full declaration defining the relevant directives and referenced standards can be obtained from your Rank Xerox representative.

 

WARNING: In order to allow this equipment to operate in proximity to industrial, scientific, and Medical (ISM) equipment, the external radiation from 
ISM equipment may have to be limited or special migration measures taken.

FCC Information

 

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

 

Class B Declaration of Conformity

 

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy 
and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded 
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the 
approval of manufacturer could void the user’s authority to operate this equipment.

 

Industry Canada Class B Notice

 

This Class B digital apparatus meets all the requirements of the Canadian Interference-Causing Equipment Regulations.

 

Avis de Conformation Classe B de l’Industrie Canada 

 

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

 

Certificate by Manufacturer/Importer

 

This is to certify that the FC07 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been 
advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.
Electronics for Imaging, Inc.

 

Bescheinigung des Herstellers/Importeurs

 

Heirmit wird bescheinigt, dass der FC07 im Uebereinstimmung mit den Bestimmungen der VFG 243/1991 Funk-Entstort ist. Der Deutschen Bundespost wurde 
das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt.
Electronics for Imaging, Inc.

 

RFI Compliance Notice

 

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.



 

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstoerbestimmungen 
geprueft. Es ist jedoch moeglich, dass die Funk-enstoerbestimmungen unter unguenstigen Umstaenden bei anderen Geraetekombinationen nicht eingehalten 
werden. Fuer die Einhaltung der Funk-entstoerbestimmungen seigner gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen 
ist der Betreiber verantwortlich.

 

Software License Agreement

 

Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE 
ACCEPTED THE TERMS OF THIS AGREEMENT.  If you cannot or do not accept these terms, you may return the entire package within ten (10) days to 
the Distributor or Dealer from which you obtained them for a full refund.

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included 
with the Fiery ZX you have purchased, including without limitation the PostScript

 

®

 

 software provided by Adobe Systems Incorporated.

You may:

a. use the Software solely for your own customary business purposes and solely with Fiery ZX;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with Fiery ZX in a special encrypted format (“Coded 
Font Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your own 
customary business purposes on the display window of the Fiery ZX or monitor used with Fiery ZX;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to Fiery ZX provided the transferee agrees to be bound by 
all of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600720 dots per inch or greater, or to generate fonts or typefaces 
for use other than with Fiery ZX;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as 
necessary for use with the Fiery ZX unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made, 
any copies of that certain portion of the Software which has been included on the Fiery ZX hard disk drive. You may not copy the documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

 

Proprietary Rights

 

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics for Imaging 
and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except as stated above, this 
Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or 
licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or 
trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its suppliers or take any other action which impairs or reduces 
the trademark rights of Electronics for Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font 
Programs. At the reasonable request of Electronics for Imaging, you must supply samples of any Typeface identified with a trademark.

 

Confidentiality

 

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need 
to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

 

Remedies

 

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic 
termination of this license and will make available to Electronics for Imaging other legal remedies.



 

Limited Warranty And Disclaimer

 

Electronics for Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 
significant errors that make it unusable. Electronics for Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning 
Fiery ZX to Electronics for Imaging or an authorized dealer) will be, at Electronics for Imaging’s option, to use reasonable commercial efforts to attempt to correct 
or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some states 
do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

Except for the above express limited warranty, Electronics for Imaging makes and you receive no warranties or conditions on the Products, express, implied, or 
statutory, and Electronics for Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES 
OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION 
OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics for Imaging does not warrant that 
the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.

 

Limitation Of Liability

 

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST 
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 
THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE UNIT REFLECTS THIS ALLOCATION OF RISK. 
BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

 

Export Controls

 

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 
licenses. Your failure to comply with this provision is a material breach of this Agreement.

 

Government Use

 

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 
Right Clause at 48 CFR 52.227-19, as applicable.

 

Third Party Beneficiary

 

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA  95110-2704 (“Adobe”) is a third-
party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the 
Typefaces and the Trademarks licensed hereby.  Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics 
for Imaging.

 

General

 

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font 
Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics for Imaging, Inc., Attn: Licensing Dept. or see Electronics for Imaging’s web site 
at www.efi.com.

Electronics for Imaging, Inc.
2855 Campus Drive
San Mateo, CA 94403
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ix About the documentation

 

This manual describes how to install the user software for the Fiery ZX-40 Color 
Server

 

™

 

 and set up printing from Windows computers and Mac

 

™

 

 OS

 

™

 

 computers. 
For information about setting up network servers and clients to use the Fiery ZX-40 
Color Server, see the 

 

Configuration Guide

 

. For general information on using the 
DocuColor 40, your computer, your application software, or your network, see the 
manuals that accompany those products.

 

N

 

OTE

 

:

 

This manual uses the term “Fiery ZX” to refer to the Fiery ZX-40 Color Server.

The Fiery ZX includes Command WorkStation

 

™

 

 software, which enables an operator 
to manage all jobs sent to the Fiery ZX. Although it may not be the case at all sites, the 
documentation for this product assumes the presence of an operator who controls and 
manages jobs sent by users from remote workstations.

Your Fiery ZX includes a media pack containing:

• User Software CD

• System Software CD

• User Documentation CD

• Printed Release Notes (described below)

• Quick Start Notes

 

About the documentation

 

This manual is part of the set of Fiery ZX documentation that includes the following 
manuals for users and system administrators:

• The 

 

Configuration Guide

 

 explains basic configuration and administration of the 
Fiery ZX for the supported platforms and network environments. It also includes 
guidelines for setting up UNIX, Windows NT, and NetWare servers to provide 
PostScript printing services to clients.

•

 

Getting Started 

 

describes how to install software to enable users to print to the 
Fiery ZX. Specifically, it describes installation of PostScript printer drivers, printer 
description files, and other user software provided on the User Software CD. It also 
explains how to connect each user to the network.

Introduction



 

x Introduction

 

• The 

 

Printing Guide

 

 describes the printing features of the Fiery ZX for users who 
send jobs via remote workstations on the network or via a direct parallel port 
connection.

• The 

 

Color Guide

 

 provides an introduction to the basics of color theory and printing 
to a Fiery ZX Color Server. It also includes practical color printing tips and 
application notes that explain how to print to the Fiery ZX from popular Windows 
and Mac OS applications.

• The 

 

Job Management Guide

 

 explains the functions of the Fiery ZX client utilities, 
including the Command WorkStation, and how they can be used to manage jobs 
and maintain color quality. This book is intended for an operator or administrator, 
or a user with the necessary access privileges, who needs to monitor and manage job 
flow, perform color calibration, and troubleshoot problems that may arise. 

•

 

Release Notes

 

 provide last-minute product information and workarounds for some of 
the problems you may encounter.

 

Specifications

 

The Fiery ZX-40 Color Server has the following features:

• DEC Alpha 21164 CPU, 533 MHz, 256MB RAM (512MB upgrade option 
available)

• PRIME video interface board

• Internal 8GB hard disk drives (additional 4GB upgrade option available)

• Internal 12x rotational rate CD-ROM drive (read-only)

• Internal Iomega ZIP

 

™

 

 drive (storage capacity 100MB)

• Supports additional SCSI devices with an SCSI host adapter card

• Supports AppleTalk, TCP/IP, and IPX protocols simultaneously

• Supports parallel port communication

• Supports EtherTalk Phase 2

• Supports thinnet (thin coaxial Ethernet cable or 10Base2), thicknet (thick coaxial 
Ethernet cable or 10Base5), and unshielded twisted pair (Fast Ethernet 100BaseTX 
or Ethernet 10BaseT)

• Supports Token Ring networking with additional optional hardware



 

xi User software

 

• Supports Adobe PostScript 3

• Includes 136 fonts (117 Adobe Type 1 PostScript and 19 TrueType)

In addition, two Adobe Multiple Master fonts are included and are used for font 
substitution in PDF files.

You can use the Fiery Downloader to download additional fonts.

• Built-in ColorWise

 

™ 

 

color management and NetWise

 

™

 

 networking management

• Fiery WebTools

• Fiery Downloader client utility

• Command WorkStation software, including embedded versions of the Fiery 
Downloader and Fiery Print Calibrator

 

User software

 

The Fiery ZX user software is provided on the User Software CD. 

 

N

 

OTE

 

:

 

Installers for printer files can also be downloaded from the Fiery ZX using 
Fiery WebTools (see page 60). 

Adobe PostScript Printer Drivers 
(for Windows 95, 
Windows 3.1x, and Mac OS 
only) and PostScript Printer 
Description files (PPDs)

To print to the Fiery ZX. These drivers and PPDs 
support PostScript Level 3 and provide access to all 
special features of the DocuColor 40.

Screen Fonts 
(for Mac OS only)

Screen fonts for the 136 PostScript printer fonts 
installed on the Fiery ZX.

Fiery Downloader

 

™

 

(For Windows 95, 
Windows NT 4.0, and 
Mac OS only)

Enables you to print PostScript files, Encapsulated 
PostScript (EPS) files, and Portable Document 
Format (PDF) files directly to the Fiery ZX without 
opening the application in which they were created. 
The Fiery Downloader also enables you to 
download printer fonts to the Fiery ZX. 

Fiery Booklet Maker An XTension for QuarkXPress that enables you to 
reorder pages automatically for proper booklet 
printing.



 

xii Introduction

 

System requirements

 

Fiery ZX user software is provided on a CD. To install the user software on a Windows 
or Mac OS computer, the computer must be equipped with a CD-ROM drive (either 
built-in or external).

 

Windows

 

To print to the Fiery ZX, you need:

• A Windows-based computer with an 80486, AMD, or Pentium processor

• Windows 95, Windows 3.1x, or Windows NT 4.0

• At least 4MB of RAM

To use the Fiery Downloader you also need:

•

 

Either

 

 Windows 95 

 

or

 

 Windows NT 4.0 with NT Service Pack 3

• At least 16MB of RAM

Color Reference Files Reference pages that you can print to view the range 
of colors available with your Fiery ZX. For most 
predictable color results, refer to these pages when 
defining colors in applications. 

Color Management Files Profiles for use with the color management systems 
implemented in Mac OS and Windows operating 
systems, and Separation Tables and a monitor 
settings file for use with Adobe

 

®

 

 Photoshop

 

®

 

.

Command WorkStation v3.2x  A software application that allows an operator to 
control Fiery ZX functions from a networked 
Windows NT 4.0 workstation. 
The Command WorkStation software includes 
embedded versions of the Fiery Downloader and 
Fiery Print Calibrator utilities.



 

xiii System requirements

 

To use the Fiery WebTools, you also need:

•

 

Either

 

 Netscape Communicator v4.0.3 with Java enabled 

 

or

 

 Microsoft Internet 
Explorer v3.0.2 with Java enabled

 

N

 

OTE

 

:

 

Netscape and Microsoft continue to release frequent updates to their browsers. 
As support cannot be guaranteed for all versions, use the versions specified above for 
best results.

• A monitor that supports 16-bit color at a minimum resolution of 600 

 

x

 

 800

• A TCP/IP enabled network and the IP address or DNS name of the Fiery ZX

• Web Services enabled on the Fiery ZX

 

N

 

OTE

 

:

 

The Fiery utilities and WebTools are supported with Windows 95 and 
Windows NT 4.0 only.

With Microsoft Windows 95, you also need:

• IPX/SPX or TCP/IP networking protocol installed

• Adobe PostScript Printer Driver for Windows version 4.2 or later (version 4.2.1 is 
included with the user software)

With Microsoft Windows 3.1x, you also need:

• IPX networking protocol installed

• IPX/SPX networking software for IPX/SPX communication

• MS-DOS version 5.0 or later

• Adobe PostScript Printer Driver for Windows version 3.0 or later (version 3.0.1 is 
included with the user software)

With Microsoft Windows NT 4.0 you also need:

• TCP/IP or AppleTalk networking protocol installed

• The Windows PostScript Printer Driver that came with your Windows NT 4.0 
system software; however, some Fiery ZX printing features may not be available. For 
details, see the 

 

Printing Guide

 

.



 

xiv Introduction

 

Mac OS

 

To print to the Fiery ZX you need:

• A Mac OS-based computer

• At least 8MB of RAM

• EtherTalk installed

• Apple System software version 7.5 or later

• Adobe PostScript Printer Driver version 8.5 or later (version 8.5.1 is included with 
the user software)

To use the Fiery Downloader you also need:

• A Power Macintosh computer

• At least 16MB of RAM

To use the Fiery WebTools, you also need:

• Netscape Communicator v4.0.3 or later with Java enabled

 

N

 

OTE

 

:

 

Netscape continues to release frequent updates to its browser. As support cannot 
be guaranteed for all versions, use the version specified above for best results.

• A TCP/IP enabled network and the IP address or DNS name of the Fiery ZX

• Web Services enabled on the Fiery ZX

 

UNIX (TCP/IP)

 

To print to the Fiery ZX with a UNIX workstation, you need:

• A workstation with standard TCP/IP connectivity (for example, Sun SPARCstation 
or Silicon Graphics workstation with Solaris version 2.x or SunOS version 4.1.x 
software)

• TCP/IP printing software that conforms to RFC1179 (Berkeley lpd protocol)



 

xv System requirements

 

Parallel port

 

To print to the Fiery ZX using the parallel port, you need:

• A Windows-based computer with an 80486, AMD, or Pentium processor

• At least 4MB of RAM

• The parallel cable included with the Fiery ZX

The cable has a DB-25 male connector (that connects to the computer) on one end 
and a DB-25 female connector (that connects to the Fiery ZX) on the other.

 

IPX (Novell)

 

To use the Fiery ZX with an IPX (Novell) network, you need:

• A Novell server

• Novell NetWare software version 4.x or 3.x

• Support for Ethernet SNAP, Ethernet II, Ethernet 802.3, Ethernet 802.2, 
Token Ring SNAP, or Token Ring

 

Command WorkStation

 

To run the Command WorkStation application from a remote workstation, you need:

• A Windows-based computer with a 200 MHz Pentium processor

• Windows NT 4.0 with NT Service Pack 3

• TCP/IP networking protocol installed

• PCI VGA interface card

• At least 32MB of RAM

• At least 2MB of video RAM

• An 850MB IDE hard disk drive

• A 2

 

x

 

 CD-ROM drive

• A 17" monitor that supports 16-bit color at a minimum resolution of 1024 

 

x

 

 768



 

1

 

This chapter describes installing software and setting up printing from a Windows-
based computer running Windows 95, Windows 3.1x, or Windows NT 4.0. 

The general steps for installing the Fiery ZX software are:

• Install the Adobe PostScript Printer Driver (for Windows 95 and Windows 3.1x) or 
Windows printer driver (for Windows NT 4.0) and PostScript printer description 
(PPD) file, and set up the printer driver to communicate with the Fiery ZX (these 
procedures are specific to the version of Windows)

• Install the Fiery Downloader (for Windows 95 and Windows NT 4.0 only) and 
configure its connection to the Fiery ZX (page 32) 

• Install the Command WorkStation (for Windows NT 4.0 only) and configure its 
connection to the Fiery ZX (page 35)

• Copy the color reference pages from the User Software CD to your hard drive 
(page 40)

• For QuarkXPress, copy the Fiery Booklet Maker XTension from the User Software 
CD to your QuarkXPress XTensions folder (page 41)

• For PageMaker or QuarkXPress, copy the PPD file to the appropriate location 
(page 41)

• For advanced users with special color management needs, install the optional color 
management files for Photoshop and Windows ICM (page 42)

 

Downloading installers with the Fiery WebTools

 

The installers for Windows printer files that are available on the User Software CD can 
also be downloaded from the Fiery ZX using the Fiery WebTools (if the administrator 
has enabled Internet access to the server). For instructions on using the 
Fiery WebTools to download the printer files installers, see page 59.

You can use the procedures in this chapter whether you are using the User Software 
CD or an installer downloaded with the Fiery WebTools.

Installing user 
software 
on Windows 
computers
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Setting up printing with Windows 95

 

You can print to the Fiery ZX from a Windows 95 workstation over an IPX (Novell) 
network, with Windows native printing, or with the parallel port connection. In both 
cases you need to install the Adobe PostScript Printer Driver version 4.2.x for 
Windows 95 and the Fiery ZX PPD on your computer, and then set up the Fiery ZX 
to accept your print jobs. 

The procedure for installing the Adobe PostScript printer driver is the same whether 
you are installing from the User Software CD or from installer files you downloaded 
with the Fiery WebTools.
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If you have problems setting up the Fiery ZX, install another PostScript printer 
(such as the Apple LaserWriter) and then install the Fiery ZX.
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DRIVER FOR 
WINDOWS 95:

1. If you are installing from the User Software CD, open the English\Instalrs\Ps_drvr 
folder.

If you are installing from files you downloaded with Fiery WebTools, open the 
Prntdrv\Ps_drvr folder on your hard disk.

2. Open the Win_95 folder, and double-click the Setup.exe icon.

Setup is the filename for the Adobe Installer.

3. Click Read to view the README file. When you are finished, close the README file and 
click Next.
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NOTE: The information in this file is not specific to the Fiery ZX. You can click Next to 
postpone reading this file and read it later. 

4. If you are installing from the User Software CD, you may see an Install Setup Program 
dialog box offering you the option to copy the setup program to your hard disk. Make 
your choice and then click Next.

5. In the Printer Type dialog box, select Local Printer and click Next.

6. In the Install PostScript Printer from PPD dialog box, specify the drive (User Software 
CD or your hard drive) containing the Fiery ZX installer software, and browse to open 
the Ps_drvr\Win_95 folder.

7. Select the Fiery ZX printer description file for your print device (in the 
Ps_drvr\Win_95 folder) and click Next.
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8. In the Local Port Selection dialog box, select LPT1 for the port. You will configure the 
port later.

9. In the Add Printer dialog box, click Yes to use the Fiery ZX as the default printer, and 
click No to printing the test page. Click Next.

You will print the test page after you finish configuring the printer.
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The Paper properties sheet for the Fiery ZX appears. 

10. Click OK.

You are notified that Setup is complete.

11. Click Exit.

The icon for your newly installed printer appears in the Printers window.
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Completing the Windows 95 connection
To print from Windows 95 you need to:

• Set up network servers, if any

• Set up the Fiery ZX to accept print jobs from your computer

• Configure a port on each Windows 95 computer for the network or connection type

Completing the Windows 95 parallel port connection

Preparing a parallel port connection for Windows 95 requires specific BIOS settings 
on your computer, and specific port and printer settings for Windows 95. In addition, 
a change to one of the Fiery ZX Setup settings may be required if you choose to spool 
files to the Fiery ZX rather than print directly.

TO PREPARE THE FIERY ZX AND YOUR COMPUTER
FOR PARALLEL PORT PRINTING:

1. Connect the Fiery ZX to the parallel port on your computer.

For instructions, see the Configuration Guide.

2. In Network Setup > Port Setup > Parallel Port Setup, set Enable Parallel Port to Yes.

For more information about Fiery ZX Setup, see the Configuration Guide.

3. If you want to spool files to the Fiery ZX, set Port Timeout in Seconds to 10.

If you want to print directly to the Fiery ZX, set Port Timeout in Seconds to 5.

Setting this option to 10 seconds ensures that spooling is not interrupted due to 
timeout.

For this type of connection: See:

Parallel page 6

IPX/SPX or IPX (Novell) page 10

SMB printing page 13
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4. In your computer’s BIOS settings, set Parallel Port Mode to ECP.

To access the BIOS settings, restart the computer and press the key indicated on your 
monitor as soon as the computer starts up. You may have to scroll through several 
screens to reach the parallel port settings. After setting the Parallel Port Mode to ECP, 
save your changed setting and exit.

TO PREPARE THE PRINTER FOR PARALLEL PORT PRINTING:

1. Click the Start button, point to Settings, and click Printers.

2. Click the Fiery ZX printer icon and choose Properties from the File menu.

3. Click the Details tab, and in the Print to the following port pop-up menu, select 
LPT 1: (ECP Printer Port).

NOTE: Check this selection carefully. It may read LPT 1: (Printer Port), which is not 
equivalent to LPT 1: (ECP Printer Port).

If this box does not read LPT 1: (ECP Printer Port), change the port setting now, as 
described in “To prepare the port for parallel port printing:” on page 8, and then 
return to this procedure. You may need your Windows 95 system CD.

4. If you changed the selection in the Print to the following port pop-up menu, click 
Apply.

A Warning dialog box may appear, stating that fonts you downloaded to the previously 
selected port may be lost; click OK.

5. Click Spool Settings.
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6. Select either “Spool print jobs so program finishes printing faster” or “Print directly 
to the printer”.

The selection you make depends on the action you took in step 3 on page 6:

• If you set the Port Timeout in Seconds to 10, you can select either option; however, 
spooling is faster.

• If you set the Port Timeout in Seconds to 5, select “Print directly to the printer”.

7. Select “Disable bi-directional support for this printer” and click OK.

8. Click Apply.

You are now ready to print from your applications to the Fiery ZX with the parallel 
port. To confirm the connection, print a Windows 95 test page.

9. Click the General tab.

10. Click Print Test Page and click OK.

Perform the following procedure only if the LPT 1 port is not currently set to 
ECP Printer Port.

TO PREPARE THE PORT FOR PARALLEL PORT PRINTING:

1. Click the Start button, point to Settings, and click Control Panel.

2. Double-click System.

The System Properties window appears.

3. Click the Device Manager tab.
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4. Double-click Ports.

5. Double-click the port with (LPT1) in its name.

6. In the (LPT1) Properties dialog box click the Driver tab and then click Change Driver.

7. Select Show all devices.

8. From the Manufacturers list, select “(Standard port types)”. From the Models list, 
select “ECP Printer Port” (not Printer Port). Click OK.
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9. Click OK in the (LPT1) Properties dialog box.

NOTE: You might need to insert the Windows 95 system CD to complete this step 
depending on whether the required files are on your hard disk.

10. When prompted to restart the computer, click Yes.

After Windows 95 restarts, you can complete the procedure described in “To prepare 
the printer for parallel port printing:” on page 7.

Completing the Windows 95 IPX/SPX or IPX (Novell) connection

If you are printing through a Novell server, before you begin, the Novell network and 
file server should be set up. The file server should be configured with a print server and 
print connection for the Fiery ZX. For details see your NetWare documentation and 
the Configuration Guide.

NOTE: You can also use the Fiery Downloader to print directly to the Fiery ZX from 
Windows 95 with IPX/SPX.

TO SET UP IPX/SPX PRINTING:

1. Open the Windows 95 Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol and TCP/IP protocol are both listed in 
the Installed Network Components section.

For instructions, see your Windows 95 documentation.

NOTE: You must enable TCP/IP printing to ensure that all files required for IPX/SPX 
will be installed. You can select it and click Remove after you set up IPX/SPX if you do 
not need to use the TCP/IP protocol.
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3. Double-click the IPX/SPX-compatible Protocol icon.

4. Click Advanced.

5. In the Property list, click Frame Type. In the Value pop-up menu, select the Frame 
Type that corresponds to the one set during Fiery ZX Network Setup.

If necessary, print the Configuration page to check which Frame Type(s) are 
configured.

NOTE: Do not select Auto. Doing so may not select the Frame Type specified on the 
Fiery ZX.
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6. Click OK and close the Network Control Panel.

TO SET UP IPX (NOVELL) PRINTING WITH WINDOWS 95:

1. Click the Start button, point to Settings, and then click Printers.

2. Click the icon for the Fiery ZX and choose Properties from the File menu.

3. Choose the Details tab in the Properties window and click Add Port.

A list of connection options is displayed.

4. In the Add Port dialog box, specify the network path, or click Browse for a display of 
your network environment.

5. If you are using a NetWare file server, double-click the icon of the NetWare file server 
you want to use for printing to the Fiery ZX and click OK. 

6. Click the printer icon labeled with the NetWare print queue you will use and click OK.

7. In the Add Port dialog box, verify that the network path is updated and click OK.

You are ready to print from the workstation.
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Your print jobs will be transmitted to the specified print queue on the Novell file 
server. The printer will poll the file server and, if jobs are present, they will be 
transmitted to the Fiery ZX.

To confirm the connection, you can print a Windows 95 test page.

8. Click the General tab, and click Print Test Page.

9. Click OK.

Completing the SMB printing connection

If you don’t have a Novell network, you can print via SMB printing (also known as 
Windows printing or WINS printing). Printing by this method allows you to print 
from your computer to a particular queue (Hold, Print, or Direct) on the Fiery ZX.

To set up printing to a second or third queue, you must install a new printer for each 
queue and repeat the procedure “To set up SMB printing:” on page 15. If you install 
more than one printer, give each a descriptive name during printer driver installation, 
such as Astro-Print or Astro-Hold, so you can easily identify printers.

BEFORE YOU BEGIN:

1. Configure the Fiery ZX for SMB printing in Network Setup > Service Setup > 
Windows Setup.

For more information, see the Configuration Guide.

2. Print the Fiery ZX Configuration page.

You need information from the Configuration page to specify settings on your 
computer, such as the Server Name and IP address of the WINS Name Server.

3. Save any documents in open programs.

You are prompted to restart Windows after this procedure, so be sure to save any 
documents.
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TO PREPARE YOUR COMPUTER FOR SMB PRINTING: 

1. Click Start, choose Settings, and click Control Panel.

2. Double-click the Network icon.

3. Select TCP/IP and click Properties.

4. Click the WINS Configuration tab.
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5. Select “Enable WINS Resolution” and enter the TCP/IP address of the WINS Name 
Server.

6. Click OK, and click OK at the Network dialog box.

You are prompted to restart Windows. Click Yes, and when Windows restarts, 
continue with the following procedure.

TO SET UP SMB PRINTING:

1. Click the Start button, choose Settings, and click Printers.

2. Click the icon for the printer and choose Properties from the File menu.

3. Click the Details tab in the Properties window and click Add Port.

A list of connection options is displayed.

4. In the Add Port dialog box, click Browse to display your network environment.
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5. Expand the levels to locate your printer and the queue to which you want to print.

The printer name you are browsing for is the name entered in Network Setup > 
Service Setup > Enable Windows Printing > Server Name, not the Server Name 
entered in Server Setup. Refer to the Configuration page for this information.

The amount of network traffic determines the amount of time required for the Browse 
function.

6. Select the queue under the printer and click OK.

7. In the Add Port dialog box, verify that the network path is correct and click OK.

8. To confirm the connection, click the General tab in the Properties dialog box.

9. Click Print Test Page, and click OK.

If the test page prints successfully, you are ready to print from the computer.
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Setting up printing with Windows 3.1x
To print with Windows 3.1x, you need to install the Adobe PostScript Printer Driver 
v3.0.1 and the Fiery ZX PPD (printer description file) on your computer and then 
perform the set up procedures required for the Fiery ZX to accept your print jobs. 

The procedure for installing the Adobe driver is the same whether you are installing 
from the User Software CD or from installer files you downloaded with the 
Fiery WebTools.

TO INSTALL THE ADOBE POSTSCRIPT PRINTER DRIVER FOR 
WINDOWS 3.1X:

1. In the Main window, double-click the Control Panel icon.

2. Double-click the Adobe PostScript Printers icon.

The Install PostScript Printer from PPD dialog box appears.

3. If you installing from the User Software CD, open the English\Instalrs\Ps_drvr\Win_31 
folder.

If you are installing from files you downloaded using the Fiery WebTools, open the 
Ps_drvr\Win_31 folder on your hard disk.

4. Select the Fiery ZX PPD from the Printer Descriptions available box and click Install.

5. Click OK when you are notified that the printer was successfully installed.
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Setting the Fiery ZX as the default printer with Windows 3.1x
You can specify the Fiery ZX as the default printer. Many Windows applications use 
the default printer when you choose the Print command.

TO SET THE FIERY ZX AS THE DEFAULT PRINTER:

1. In the Control Panel window, double-click the Printers icon.

2. In the Printers window, select the Fiery ZX in the Installed Printers list box.

3. Click Set As Default Printer.

The Fiery ZX appears in the Default Printer area of the Printers window.

Selecting a printer port with Windows 3.1x

When you install a printer, Windows assigns it to a default printer port. If the 
Fiery ZX is connected to your computer through a network or you want to assign it to 
a different port, you need to change the port assignment. For information on which 
port to use, see your system administrator.

You can use this procedure to enable printing with the parallel port.

TO SELECT A PRINTER PORT:

1. In the Control Panel window, double-click the Printers icon.

2. In the Printers window, select the Fiery ZX in the Installed Printers list box.

3. Click Connect.
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4. Connect the Fiery ZX to the same port as your network.

For parallel printing, select the port (LPT1, LPT2, or LPT3) connected to your 
parallel cable.

To print to a file, select FILE port. Printing to a file is useful if the Fiery ZX is 
elsewhere or off-site. However, if you select the FILE port, you cannot print to a 
printer until you select a network or printer port. (In some applications, you can select 
the FILE port from the Print dialog box; this is preferable for temporary use since it 
doesn’t require resetting the port in the Control Panel.) 

5. Click OK.

The Printers window appears again, with the selected port next to the selected printer 
name in the Installed Printers list box.

6. When you are finished, click OK and then click Close.

Setting up IPX (Novell) printing with Windows 3.1x

TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS:

1. In the Main group of the Windows Program Manager, double-click the Windows Setup 
icon.

2. From the Options menu, choose Change System Settings.

Double-click here
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3. From the Network pop-up menu, choose Novell NetWare (shell versions 3.26 and 
above).

4. Click OK. When prompted, restart Windows.

5. In the Main group, double-click Control Panel, then double-click Printers. 

6. In the Printers Control Panel window, click Connect to connect the printer to the 
appropriate port.

7. Select Network.

If you are printing to a file, select FILE. Printing to a file is useful if the printer is 
elsewhere or off-site. However, if you select the FILE port, you cannot print to a 
printer until you select a network or printer port. If you select Network, the next 
window depends on the NetWare client driver version.

8. If the Network Printer Connections dialog box is displayed, select the port in the 
Printer connections box.
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9. In the Available queues list box, select the server and queue name that correspond to 
the Fiery ZX.

10. Click the Connect button and then click the Close button.

The Connect dialog box is displayed with the network path to the printer.

11. Click OK in the Connect dialog box.

The Printers window appears again, with the selected port next to the highlighted 
printer name in the Installed Printers list box. 

12. Click Close in the Printers dialog box.

You are now ready to print to the Fiery ZX from Windows applications. When you 
select Print, jobs are routed to the print queue on the NetWare file server, and then 
transmitted to the Fiery ZX. The network administrator should verify the network 
connection by printing a test document from each networked computer that will use 
the Fiery ZX. 

Setting up printing with Windows NT 4.0
To set up Windows NT 4.0 printing, install the Windows NT PostScript printer driver 
and configure printing for your network type. Fiery ZX printer files support 
Intel-based Windows NT 4.0.

The procedure for installing the printer files is the same whether you are installing 
from the User Software CD or from installer files you downloaded with the 
Fiery WebTools.

TO INSTALL THE FIERY ZX PPD AS A LOCAL PRINTER WITH THE 
WINDOWS NT 4.0 POSTSCRIPT PRINTER DRIVER:

1. Insert the User Software CD into the CD-ROM drive.

2. Click Start in the Windows NT taskbar, choose Settings, and then choose Printers.

3. Double-click Add Printer.
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4. To install a printer locally, select My Computer and click Next.

“My Computer” is available if you logged in to a computer on which you have 
Administrator privileges. If it is not available, you can add a network printer. The 
procedure is similar to adding a port (see page 28).

5. Select LPT1: and click Next.

This is a general installation that works for the parallel port connection. You can add a 
network port later, according to your network type.
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6. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install from Disk dialog box prompts you for the disk.
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7. If you are installing from the CD, browse to the English\Instalrs\Ps_drvr\Win_nt4x 
folder and click Open.

If you are installing from the installer files you downloaded with the Installer 
WebTool, browse to the PrntdrvPrntrDrv\Ps_drvr\WIN_NT4x folder and click Open.

8. In the Locate File dialog box, navigate to the English\Instalrs\Ps_drvr\Win_nt4x 
folder and open it.

9. With the Ntprint.inf file selected, click Open.

The path is copied to the next dialog box.

10. In the Install from Disk dialog box, click OK to install the DocuColor 40 PPD from the 
path you chose.

11. Make sure that the Fiery ZX is selected in the Printers list, and click Next.
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12. Using a maximum of 20 characters, enter a name for the Fiery ZX (or leave the default 
name) in the Printer name box, and choose whether you want it to be your default 
printer. Click Next.

13. Indicate whether you want the printer installed as a shared printer. Click Next.

If you select Shared, you must also enter a Share Name for the printer (or leave the 
default name) and make selections from the list of operating systems used by client 
workstations. For information on shared printers, see the Configuration Guide.

14. Click No in the next dialog box to postpone printing a test page, and click Finish.

TO COMPLETE INSTALLATION OF THE WINDOWS NT 4.0 
POSTSCRIPT PRINTER  DRIVER:

If the Files Needed dialog box appears, it prompts you to locate the Windows NT 
PostScript driver Pscript.dll.
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1. If this is the first PostScript printer on your system:

• Eject the User Software CD and insert the Windows NT Installation CD.

• In the text field, type the name of the CD-ROM drive (for example, D:\), and click 
Browse.

• Browse to i386 (the folder containing the PostScript driver).

If you have already installed a PostScript printer on your system:

• In the text field, type the name of the hard drive (for example, C:\), and click 
Browse.

• Browse to winnt\system32\spool\drivers\w32x86 (the folder containing the 
PostScript driver).

2. Click OK, then click OK in the Files Needed dialog box.

When installation is complete, the Printers window appears with an icon for the newly 
installed printer.

3. Complete the printer connection according to your network type.

Completing the Windows NT 4.0 printer connection
To print from Windows NT 4.0 you need to:

• Set up network servers, if any.

• Set up the Fiery ZX to accept print jobs from your computer.

• Configure a port on each Windows NT computer for the network or connection 
type

To do this: See:

Configure the parallel connection “Completing the Windows 4.0 parallel 
port connection” on page 27

Configure the TCP/IP (lpr port) 
connection

“Completing the Windows NT 4.0 
TCP/IP connection” on page 27

Configure the IPX (Novell) 
connection

“Completing the Windows NT 4.0 IPX 
(Novell) connection” on page 30
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Completing the Windows 4.0 parallel port connection

The parallel port cable connects the Fiery ZX to a single computer. 

Once you have installed the Windows NT PostScript printer driver and the Fiery ZX 
PPD, complete the setup for parallel port printing as follows.

TO SET UP PARALLEL PRINTING FOR WINDOWS NT 4.0:

1. Click the Start button, choose Settings, and then choose Printers.

2. Double-click the Fiery ZX icon and choose Properties from the Printer menu.

In the Ports property sheet, confirm that LPT1 (Local Port) is checked.

The Fiery ZX is ready to accept parallel print jobs from your computer, using the 
Windows NT PostScript printer driver and the Fiery ZX PPD. 

3. Click the General tab and click Print Test Page.

4. Select the Sharing tab if you want to share the Fiery ZX with network users. Select 
Shared, and select a share name.

Select the operating system or systems used by your network clients if you want to 
install a printer driver that those clients can download.

5. Click OK to exit the Printer Properties dialog box.

Completing the Windows NT 4.0 TCP/IP connection

Once you have installed the Windows NT 4.0 PostScript driver and the Fiery ZX 
PPD, complete the setup for the TCP/IP and lpr connection as follows:

• Prepare the Fiery ZX to accept print jobs using TCP/IP and lpr protocols. (For 
details, see the Configuration Guide.)

• Configure the workstation for the TCP/IP connection.

Before you continue, ask the system administrator for the IP address assigned to the 
Fiery ZX, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP Protocol and Microsoft TCP/IP Printing software should already be 
installed on the Windows NT workstation.T



28 Installing user software on Windows computers

TO SET UP TCP/IP AND LPR PRINTING FOR WINDOWS NT 4.0:

1. Open the Properties dialog box for the Fiery ZX and click the Ports tab.

2. Click Add Port.

The available port types are displayed.

3. Select LPR Port and click New Port.

If the LPR port is not listed, install the TCP/IP protocols. See the Configuration Guide 
or your Windows NT documentation.
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4. Enter the IP address of the Fiery ZX. 

If your network uses Domain Name Services (DNS), enter the DNS name assigned to 
the Fiery ZX instead of the IP address.

5. Press Tab and type the internal name of the Fiery ZX.

This name can be simply the print queue name or it can be of the form 
queue_devicename. The name you enter must be one of the following:

print_DocuColor
hold_DocuColor
print
hold

NOTE: This name is case sensitive; type it exactly as shown above.

6. Click OK.

The workstation checks the address or DNS name you entered and notifies you if it 
cannot resolve the address.

7. Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You should now print a test 
page to verify the connection.

8. Click the General tab and click Print Test Page.

When you print, your PostScript files are transmitted over the LPR Port connection to 
the Fiery ZX. 

9. Click OK to exit the Printer Properties dialog box.
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Completing the Windows NT 4.0 IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling Fiery ZX print jobs. The 
file server should be configured with a print server and print connection for the 
Fiery ZX. For details, see your NetWare documentation.

• Prepare the Fiery ZX for IPX printing.

• Set up the IPX connection on the workstation.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 
services should already be installed on the Windows NT workstation.

TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS NT 4.0:

1. Double-click Network Neighborhood.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers is displayed.

3. Double-click the NetWare Tree or File Server on which the network administrator 
defined a print connection for the Fiery ZX.

You may have to log in to the file server as guest to see the print connections.

4. Double-click the print connection defined for the Fiery ZX.

If the NetWare server does not have a suitable driver for the Fiery ZX you may be 
asked if you want to set up the printer on your workstation.
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5. Click Yes.

The Add Printer Wizard appears.

6. Specify if you print from MS-DOS programs and click Next.

If you select Yes, you will need to capture a printer port before continuing.

7. Install the Fiery ZX PPD (start with step 6 on page 23).

When installation is complete, a new printer window appears, with the name of the 
print queue on the NetWare server.

8. Choose Properties from the Printer menu and click the Ports tab.

The NetWare queue you just connected to is listed and checked as a port for the 
Fiery ZX.
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9. Click the General tab and click Print Test Page.

The Fiery ZX polls the NetWare server for print jobs in the print connection defined 
for the Fiery ZX. When you print, your PostScript files are spooled to that connection 
and transmitted over the queue “port” to the Fiery ZX.

The test page job is listed in the queue window until it is printed.

Installing client utility software
The User Software CD includes software installers for the Fiery Downloader and the 
Command WorkStation. These client utilities must be separately installed on each 
client computer that will use them.

NOTE: The Command WorkStation software includes embedded versions of the Fiery 
Downloader and Fiery Print Calibrator utilities.

Installing the Fiery Downloader
The Fiery Downloader allows you to print PostScript, EPS, and PDF files directly to 
the Fiery ZX without opening the originating application. The Fiery Downloader can 
also be used to download fonts to the Fiery ZX hard disk if the Direct connection is 
published. 

The Fiery Downloader is not supported for Windows 3.1x or Windows NT 3.51.
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TO INSTALL THE FIERY DOWNLOADER:

1. On the User Software CD, browse to the English\Instalrs\Download\Disk1 folder.

2. Double-click the Setup.exe icon.

3. Click Next in the Welcome dialog box.

4. In the Choose Destination Location dialog box, click Next to install the Fiery 
Downloader in the default folder, or click Browse to select a different folder, and then 
click Next.
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5. In the Select Program Folder dialog box click Next to install into the default Program 
Folder, or specify a different folder name, and then click Next.

6. In the Start Copying Files dialog box, verify the information and then click Next.

Information about installation progress appears on the screen. 

7. Click OK when you are informed that installation is complete.

The first time you run the Fiery Downloader, you must configure the connection to 
the server as described on page 36. 
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Installing Command WorkStation software
The Command WorkStation software installer is included on the User Software CD. 
In addition to the Command WorkStation application software, the installer installs 
Java files necessary to use Fiery Setup on the Command WorkStation. Before you 
begin this installation, determine the following:

Where do you want to install the software on your hard disk?

By default, the installer places the Command WorkStation software in a folder 
named “Cstation”, on the top level of your hard disk.

• What you want to name the Command WorkStation folder in the 
Windows\Start Menu\Programs folder?

By default, the installer names the folder “Command WorkStation”.

• Do you want to place a shortcut to the Command WorkStation application in your 
Windows\Start Menu\Programs\StartUp folder?

Placing a shortcut in the StartUp folder automatically launches the Command 
WorkStation application every time you restart your computer.

TO INSTALL COMMAND WORKSTATION SOFTWARE:

1. On the User Software CD, double-click to open the English\Instalrs\CWS\Disk1 folders.

2. Double-click the Setup.exe icon.

3. Follow the instructions in the Setup dialog boxes to complete installation of Command 
WorkStation software.

Use the table below as a guide when installing Command WorkStation software. For 
specific instructions, read the information in each dialog box.

Name of dialog box: Action: When finished:

Welcome Read the Setup program 
introduction.

Click Next.

Choose Destination Location Specify a hard disk location for the 
installed Command WorkStation 
software.

Click Next.
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The first time you use the Command WorkStation, you must configure the connection 
to the Fiery ZX as described in the following section.

Configuring the connection to the server
Before you can use the Command WorkStation or the Fiery Downloader, you must 
configure the connection to the Fiery ZX. This procedure automatically edits a file 
named Efinl.ini that is created in your Windows folder the first time you launch any of 
the client utilities. 

NOTE: The same configuration information (the Efinl.ini file) is used when connecting 
to Fiery Downloader, Fiery Print Calibrator, and the Command WorkStation, so any 
change affects the connection configuration of all three utilities.

Select Program Folder Specify a folder name for the 
Command WorkStation software 
located in the Programs menu.

Click Next.

Start Copying Files Verify the information in the 
Current Settings area.

Click Next.

Question Indicate if you want to place a 
shortcut to the Command 
WorkStation application in your 
StartUp folder.

Click Yes or No.

Java (TM) Support Indicate that you want to install Java 
files onto your hard disk.

These files are necessary for using 
Fiery Setup on the Command 
WorkStation.

Click Yes.

Java (TM) Support Read the License Agreement. Click Yes.

Java (TM) Support Acknowledge that the software 
installation is complete.

Click OK.

Java (TM) Support Indicate that you want to restart 
your computer in order to use the 

Command WorkStation software

Click Yes.

Name of dialog box: Action: When finished:



37 Installing client utility software

BEFORE YOU BEGIN:

• If you are using IPX/SPX, print the Configuration page from the Control Panel and note 
the IPX address for the Fiery ZX.

In general, you should use the Ethernet IPX address. If you are connected through a 
Token Ring network, use the Token Ring IPX address.

• If you are using TCP/IP, print the Configuration page from the Control Panel and note 
the IP Address of the Fiery ZX. 

You can also set up a Domain Name Server (DNS) for the IP address of the Fiery ZX 
in the printcap file and use that name. See your Windows system documentation for 
information.

TO CONFIGURE THE CONNECTION TO THE FIERY ZX:

1. Launch the utility by choosing it from the Start\Programs menu.

If this is the first time you are using either the Fiery Downloader or the Command 
WorkStation on this computer, the following message is displayed. 

2. Click OK.

3. In the Add New Server dialog box, enter the following information:

Nickname—Enter a name for the Fiery ZX. This name can be any name you wish; it 
does not have to match the actual Server Name of the Fiery ZX.

NOTE: The Nickname cannot contain the following seven characters:
[ ] _ " ' <space> <tab>

Protocol—Select TCP/IP for the Command WorkStation. Select either TCP/IP or IPX 
for the Fiery Downloader.

NOTE: Fiery Setup from the Command WorkStation is supported over TCP/IP only.
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Server Name—If you are using TCP/IP, enter the IP address or DNS name of the 
server. If you are using IPX/SPX, enter the Server Name exactly as it was defined 
during Setup (see the Configuration Guide). This entry is case sensitive.

IPX Address—If you selected IPX for the Protocol, enter the IPX address of the server. 

New Device—Enter the device name: DocuColor. This device name appears in the 
Printer Setup section of the Configuration page.

4. When you have entered all the information, click Add.

The device name now appears in the Devices list.

For TCP/IP networks For IPX/SPX networks
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5. Click OK.

The Fiery ZX entry appears in the list of available servers. The first line of the entry 
displays the nickname you gave the server, followed by the protocol you chose. The 
second line displays the device name. 

6. With the device name selected, click OK to connect to the Fiery ZX.

To modify the configuration, select the server nickname and click Modify. To remove 
the configuration, select the server nickname and click Remove. To configure a 
connection to another server, click Add. 

For information on using the Command WorkStation and the Fiery Print Calibrator, 
see the Job Management Guide. For information on using the Fiery Downloader, see 
the Printing Guide. 
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Copying color files from the User Software CD
The color files included on the User Software CD let you see the range of colors the 
Fiery ZX can produce. You can be assured of predictable color results if you use the 
color reference pages when defining the colors you want to use in your document. For 
more information, see the Color Guide.

Also included are calibration files for expert users of Fiery Print Calibrator.

The Clrfiles folder contains the following files:

Color file(s): Description:

CMYK_ref.ps A PostScript file (11 letter-size pages) of CMYK color 
patches—download this file and refer to the printed output 
when defining CMYK colors in applications.

Rgb_01.doc
Rgb_02.ppt

A Microsoft Word 6.0 file (Rgb_01.doc) and a PowerPoint 
4.0 file (Rgb_02.ppt)—use these files to view the colors 
available in the standard palettes of RGB-based applications 
and to see how those colors print on the Fiery ZX.

Pantone.ps The PANTONE Coated Color Reference Book—a 
downloadable PostScript file of color patches showing 
CMYK equivalents of PANTONE Coated colors. This file 
prints differently depending on the setting of the Spot Color 
Matching print option. 

Calibrat (folder) Four PostScript measurements files of color patches: 
Custom21.ps, Custom34.ps, Stand21.ps, and Stand34.ps. 
The numbers in the filenames refer to the number of 
patches on the page.
The Custom files are provided to enable you to download 
measurement patches that incorporate the copier’s current 
calibration set. The Standard files are provided to enable you 
to download standard measurement patches that ignore the 
copier’s current calibration set.
NOTE: These files are provided for expert users and should 
not be used for day-to-day calibration
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Installing Fiery Booklet Maker for QuarkXPress
If you will use the Fiery Booklet Maker XTension, you must copy it into the 
QuarkXPress XTensions folder. 

NOTE: With Fiery Booklet Maker installed, QuarkXPress may take longer to start up; 
you should install it only if you will use it.

TO INSTALL THE FIERY BOOKLET MAKER XTENSION:

1. On the User Software CD, open the English\Bklt_mkr folder.

2. Copy the file Booklet.xxt to a floppy disk.

3. Select the Booklet.xxt file on the floppy disk and display its Properties. 
(Click the right mouse button and select Properties from the pop-up menu.) 

4. In the Attributes section of the Properties dialog box, make sure that Read-only is not 
checked.

5. Click Apply and then OK.

6. From the floppy disk, copy the Booklet.xxt file to the XTENSION folder in your 
QuarkXPress folder. 

Copying the printer description files for applications
The User Software CD contains printer description files for popular Windows 
applications. Some applications do not support automatic installation of printer 
description files from the Printers Control Panel. To make printer features available in 
the Print and Page Setup dialog boxes of these applications, copy the printer 
description file to the appropriate location.

You might want to provide copies of the printer description file to customers. This 
ensures that jobs they create and print to files are properly formatted for printing to the 
Fiery ZX.
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TO COPY THE PRINTER DESCRIPTION FILES:

1. On the User Software CD, open the English\Instalrs\Ps_drvr folder, and then open the 
Win_95, Win_31, or Win_nt4x folder, depending on the version of Windows you are 
using.

2. Copy the printer description file for your Fiery ZX to the appropriate location.

Optional color management files
The built-in color management system of the Fiery ZX produces high-quality color 
output without the use of platform-specific or application-specific color management 
tools. For advanced users who need them for specialized purposes, optional color 
management files for Photoshop and for Windows ICM are provided on the User 
Software CD. Perform the following installation procedures only if you need to use 
these optional color management files. For information on Fiery ZX color 
management, see the Color Guide.

Photoshop color management files
Included on the User Software CD are custom Separation Tables for the 
DocuColor 40 and a Calrgb.ams monitor settings file that defines the optimal source 
color space for printing to the Fiery ZX.

If you use: Copy this file: To this location:

PageMaker 5.0 or 
later

Efax4010.ppd For PageMaker 5.0, 
\ALDUS\USENGLSH\PPD4
For PageMaker 6.0, 
\PM6\RSRC\USENGLSH\PPD4
For PageMaker 6.5, 
\PM65\RSRC\USENGLSH\PPD4

QuarkXPress 3.2 
or later with 
Windows 3.1x or 
Windows 95

Efax4010.ppd For QuarkXPress 3.1 or 3.2, the QuarkXPress 
home folder, usually \XPRESS
For QuarkXPress 3.3 or later, the PDF folder, 
usually \XPRESS\PDF

QuarkXPress 3.2 
or later with 
Windows NT 4.0

Efax4010.ppd System folder
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TO PREPARE FOR LOADING THE PHOTOSHOP FILES

1. On the User Software CD, open the Photoshp folder.

This folder contains the following files:

Calrgb.ams
Dc40p.ast
Dc40s.ast

2. Copy all the files in the Photoshp folder to the Photoshop application folder on your 
hard drive.

3. Launch Photoshop.

Loading the Separation Tables

The Separation Tables enable RGB-to-CMYK conversions within Photoshop that 
correspond to conversions performed by color rendering dictionaries on the Fiery ZX.

TO LOAD THE SEPARATION TABLES:

1. Perform the steps described in “To prepare for loading the Photoshop files” on 
page 43.

2. For Photoshop 4.0, from the File menu, choose Color Settings>Separation Tables.

For Photoshop 3.0, from the File menu, choose Preferences>Separation Tables.

3. In the Separation Tables dialog box, click Load.
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4. Browse to the Photoshop folder, select the appropriate file, and click Open (Photoshop 
4.0) or OK (Photoshop 3.0).

Select the Dc40p.ast file for separating photographic RGB images to CMYK. 
Select the Dc40s.ast file for separating solid color RGB images to CMYK.

5. Verify that the file you selected appears after “Use Table:” in both places and click 
OK.

Separation tables remain loaded the next time you start Photoshop, unless you remove 
them.

Loading the monitor settings file

The Calrgb.ams monitor settings file for Photoshop defines the optimal source color 
space for use with the Fiery ZX. The color space defined by Calrgb.ams is the same as 
that defined by the EFIRGB setting of the RGB Source print option. The RGB Source 
setting overrides any monitor settings file you load in Photoshop, so if you use the 
EFIRGB setting (the default RGB Source setting), you do not need to load the Calrgb 
monitor settings file in Photoshop. If you use any setting other than EFIRGB, it 
overrides the Calrgb color space. For more information, see the Color Guide.

TO LOAD THE MONITOR SETTINGS FILE:

1. Perform the steps described in “To prepare for loading the Photoshop files” on 
page 43.

2. For Photoshop 4.0, from the File menu, choose Color Settings>Monitor Setup.

For Photoshop 3.0, from the File menu, choose Preferences>Monitor Setup.
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3. In the Monitor Setup dialog box, click Load.

4. Browse to your Photoshop folder, select the Calrgb.ams file, and click Open (Photoshop 
4.0) or OK (Photoshop 3.0).

The Calrgb.ams file appears as the selection in the Monitor pop-up menu of the 
Monitor Setup dialog box.

5. Under Room Parameters, set Ambient Light to High and click OK.

Fiery ZX ICM profiles for Windows 95
ICM profiles are provided for those who need them for specialized purposes. Install the 
Fiery ZX ICM profile only if you need to use it.

NOTE: The ICM profile should not be installed for printing with the Microsoft 
Office 97 suite of applications. If you print from Microsoft Office 97 with the ICM 
profile installed, JPEG, BMP, and TIFF images print incorrectly.
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For information on color management, see the Color Guide.

TO INSTALL THE ICM PROFILE:

1. On the User Software CD, open the ICM folder.

2. Copy the Efax4010.icm file to the WINDOWS\SYSTEM\COLOR folder on your hard drive.

3. Open the WINDOWS\SYSTEM\COLOR folder on your hard drive and right-click to select 
the Efax4010.icm file.

4. Choose Install in Place from the menu that appears.

The icon of the Efax4010.icm file is now white, indicating that the ICM profile is 
installed.
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The general steps for installing the Fiery ZX user software and setting up printing on a 
Mac OS computer are:

• Install the printer files (Adobe® PostScript® Printer Driver version 8.5.1 and 
Fiery ZX PostScript printer description file), and set up the Fiery ZX in the Chooser 
(page 47)

• Install the screen fonts that correspond to the built-in printer fonts (page 50)

• Install the Fiery Downloader (page 50)

• Copy the color reference pages from the User Software CD to your hard drive 
(page 51)

• For QuarkXPress, copy the Fiery Booklet Maker XTension from the User Software 
CD to your QuarkXPress XTensions folder (page 53)

• For advanced users with special color management needs, install the optional color 
management files for Photoshop and ColorSync (page 53)

If you operate the Fiery ZX in a pay-for-print business, you should provide copies of 
the printer driver, printer description file, ColorSync profiles, Photoshop Separation 
Tables and monitor settings file, and relevant documentation to customers. This helps 
ensure that jobs they create are properly formatted for printing on the DocuColor 40.

Installing printer files
The AdobePS 8.5 Installer automatically installs the Adobe PostScript Printer 
Driver v8.5.1, the printer description file for the DocuColor 40, and the Apple 
Chooser 7.5x (if you are using an earlier version). 

The installer files are available on the User Software CD and can also be downloaded 
from the Fiery ZX using the Fiery WebTools (if the administrator has enabled Internet 
access to the server). For instructions on using the Fiery WebTools to download the 
installer files, see page 59.

Installing user 
software on 
Mac OS 
computers
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You can use the following procedures whether you are using the User Software CD or 
the installer files downloaded with the Fiery WebTools.

TO INSTALL THE ADOBEPS PRINTER DRIVER AND PPD FILES

1. If you are installing from the User Software CD, open the Installers:Printer Driver 
folder.

If you are installing from files you downloaded with the Fiery WebTools, open the 
Printer Driver folder on your hard disk.

2. Double-click the AdobePS 8.5 Installer icon.

A warning dialog box appears.

3. Click Yes to continue with installation of printer driver software, and to confirm that 
your computer must be restarted after installation.

4. Click Restart when installation is complete.
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Setting up the Fiery ZX in the Chooser
After you have installed the printer files, you need to set up the Fiery ZX in the 
Chooser.

TO SET UP THE FIERY ZX IN THE CHOOSER

1. Select Chooser from the Apple menu.

2. Click the AdobePS icon.

3. Select the correct AppleTalk zone if necessary.

4. Select the name of your Fiery ZX.

5. Click Setup.

The Adobe PostScript Printer Driver automatically selects the correct printer 
description file (PPD) for your Fiery ZX. 

NOTE: The Hold queue for the Fiery ZX is always enabled; the Print queue and the 
Direct connection may also be available. If more than one Fiery ZX print connection is 
available, you must perform step 4 and step 5 for each connection.

6. Close the Chooser window.

For more information on setting up the Fiery ZX in the Chooser, see the Printing 
Guide.
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Installing screen fonts
The User Software CD includes screen fonts that correspond to the 136 built-in 
printer fonts on the Fiery ZX (see Appendix B in the Printing Guide). To use these 
fonts in your documents, you must copy them from the User Software CD to your 
System Folder.

TO INSTALL SCREEN FONTS

1. On the User Software CD, open the Fonts folder.

2. Copy the fonts that you want to install to the System Folder:Fonts folder on your hard 
disk.

If you have any applications open, you must quit and relaunch them before the newly 
installed screen fonts are available.

Installing the Fiery Downloader
The Fiery Downloader allows you to print PostScript, EPS, and PDF files directly to 
the Fiery ZX without opening the originating application. The Fiery Downloader can 
also be used to download fonts to the Fiery ZX hard disk if the Direct connection is 
enabled.

TO INSTALL THE FIERY DOWNLOADER

1. Open the Installers:Fiery Downloader folder on the User Software CD.

2. Double-click the Fiery Downloader Installer icon.
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3. Click Install.

4. When prompted, specify where to install the Fiery Downloader and the folder name to 
use, and then click Install.

You can specify any name and location for this folder. You might want to put it in the 
same folder with your other utilities.

5. When the installation is complete, click Quit in the dialog box that appears.

Copying color files from the User Software CD
The color files included on the User Software CD let you see the range of colors the 
Fiery ZX can produce. You can be assured of predictable color results if you use the 
color reference pages when defining the colors you want to use in your document. For 
more information, see the Color Guide.

Also included are calibration files for expert users of Fiery Print Calibrator.
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The Color Files folder contains the following color reference files:

Color reference file(s): Description:

CMYK Color Reference.ps A PostScript file (11 letter-size pages) of CMYK 
color patches—download this file and refer to the 
printed output when defining CMYK colors in 
applications.

RGB page 01
RBG page 02

A Microsoft Word 6.0 file (RGB page 01) and a 
PowerPoint 4.0 file (RBG page 02)—use these files 
to view the colors available in the standard palettes of 
RGB-based applications and to see how those colors 
print on the Fiery ZX.

PANTONE Book.ps The Pantone Coated Color Reference Book—a 
downloadable PostScript file of color patches 
showing CMYK equivalents of PANTONE Coated 
colors. This file prints differently depending on the 
setting of the Spot Color Matching print option. 

Calibration (folder) Four PostScript measurements files of color patches: 
Custom21.ps, Custom34.ps, Standard21.ps, and 
Standard34.ps. 
The numbers in the filenames refer to the number of 
patches on the page.
The Custom files are provided to enable you to 
download measurement patches that incorporate the 
copier’s current calibration set. The Standard files are 
provided to enable you to download standard 
measurement patches that ignore the copier’s current 
calibration set.
NOTE: These files are provided for expert users and 
should not be used for day-to-day calibration
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Installing files for QuarkXPress
If you will use the Fiery Booklet Maker XTension, you must copy it into the 
QuarkXPress XTensions folder. If you use QuarkXPress version 3.1 or 3.2, you must 
copy the DocuColor 40 printer description (PPD) file into the QuarkXPress 
application folder. 

NOTE: The following procedure assumes that you have installed the AdobePS printer 
driver and PPD file as described on page 47.

With Fiery Booklet Maker installed, QuarkXPress may take longer to start up. You 
should only install it if you intend to use it.

TO INSTALL THE FIERY BOOKLET MAKER XTENSION

1. On the User Software CD, open the BookletMaker folder.

2. Copy the Fiery Booklet Maker XTension from the CD to the XTensions folder in your 
QuarkXPress folder. 

TO INSTALL THE PRINTER DESCRIPTION FILE FOR VERSION 3.2 OR 3.1

1. On your computer, open the System Folder:Extensions:Printer Descriptions folder and 
find the Fiery ZX PPD file.

2. For QuarkXPress version 3.1 or 3.2, copy the Fiery ZX PPD file into your QuarkXPress 
folder.

Optional color management files
The built-in color management system of the Fiery ZX produces high-quality color 
output without the use of platform-specific or application-specific color management 
tools. For advanced users who need them for specialized purposes, optional color 
management files for Photoshop and for ColorSync are provided on the User Software 
CD. Perform the following installation procedures only if you need to use these 
optional color management files. For information on Fiery ZX color management, see 
the Color Guide.
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Photoshop color management files
The User Software CD includes custom Separation Tables for the DocuColor 40 and a 
Calibrated RGB monitor settings file that defines the optimal source color space for 
printing to the Fiery ZX.

TO PREPARE FOR LOADING THE PHOTOSHOP FILES

1. On the User Software CD, open the Photoshop folder.

This folder contains the following files:

Calibrated RGB
Fiery DocuColor 40.P
Fiery DocuColor 40.S

2. Copy all the files in the Photoshop folder to the Photoshop application folder on your 
hard drive.

3. Launch Photoshop.

Loading the Separation Tables

The Separation Tables enable RGB-to-CMYK conversions in Photoshop that 
correspond to conversions performed by color rendering dictionaries on the Fiery ZX.

TO LOAD THE SEPARATION TABLES

1. Perform the steps described in “To prepare for loading the Photoshop files” on 
page 54.

2.  For Photoshop 4.0, from the File menu, choose Color Settings>Separation Tables.
For Photoshop 3.0, from the File menu, choose Preferences>Separation Tables.
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3. In the Separation Tables dialog box, click Load.

4. Browse to your Photoshop folder, select the appropriate Separation Table file, and 
click Open.

Select the Fiery DocuColor 40.P file for separating photographic RGB images to 
CMYK.
Select the Fiery DocuColor 40.S file for separating solid color RGB images to CMYK.

5. Verify that the file you selected appears after “Use Table:” in both places and click 
OK.

Separation tables remain loaded the next time you start Photoshop, unless you remove 
them.
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Loading the monitor settings file

The Calibrated RGB monitor settings file for Photoshop defines the optimal source 
color space for use with the Fiery ZX. The color space defined by Calibrated RGB is 
the same as that defined by the EFIRGB setting of the RGB Source print option. The 
RGB Source setting overrides any monitor settings file you load in Photoshop, so if 
you use the EFIRGB setting (the default RGB Source setting), you do not need to load 
the Calibrated RGB monitor settings file in Photoshop. If you use any setting other 
than EFIRGB, it overrides the Calibrated RGB color space. For more information, see 
the Color Guide.

TO LOAD THE MONITOR SETTINGS FILE

1. Perform the steps described in “To prepare for loading the Photoshop files” on 
page 54.

2. For Photoshop 4.0, from the File menu, choose Color Settings>Monitor Setup.
For Photoshop 3.0, from the File menu, choose Preferences>Monitor Setup.

3. In the Monitor Setup dialog box, click Load.

4. Browse to your Photoshop folder, select the Calibrated RGB file, and click Open.

The Calibrated RGB file appears as the selection in the Monitor pop-up menu of the 
Monitor Setup dialog box.
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5. Under Room Parameters, set Ambient Light to High and click OK. 

ColorSync profiles
ColorSync profiles are provided for those who need them for specialized purposes. 
Install these profiles only if you need to use them. The following procedure installs two 
ColorSync profiles: a target profile named Fiery DocuColor 40 ICC and a ColorSync 
system profile named EFIRGB ICC. 

For information on color management, see the Color Guide.

TO INSTALL THE COLORSYNC PROFILES

1. On the User Software CD, open the Installers:ColorSync™ Profiles folder.

2. Double-click the ColorSync Profiles™ Installer icon.
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3. Click Install.

4. Browse to the ColorSync Profiles folder, located in the System:Preferences folder, and 
click Install into “ColorSync™ Profiles.”

If there is no ColorSync Profiles folder in your Preferences folder, your system is 
probably not using ColorSync. Click Cancel and then Quit to quit the Installer.

5. From the Apple menu, choose Control Panels>ColorSync™ System Profile.

6. Click Set Profile.

7. From the list of ColorSync profiles, select EFIRGB ICC and click Select.

When selected as the ColorSync system profile, EFIRGB ICC sets the optimal source 
color space for printing to the Fiery ZX. The color space set by the EFIRGB ICC 
profile is the same as that set by the EFIRGB setting of the RGB Source print option. 
For more information, see the Color Guide.

NOTE: The RGB Source print option setting overrides the ColorSync system profile 
setting. 

8. Close the ColorSync™ System Profile window.
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The Fiery WebTools allow you to manage your Fiery ZX-40 Color Server remotely via 
the Internet or your company’s intranet. Using a browser application, you can access 
the Fiery ZX home page from which you are able to select from a variety of 
Fiery WebTools. One of these, Installer, allows you to download installers for the 
Fiery ZX printer files. These installers are identical to the ones on the User Software 
CD.

For more information on using the Fiery WebTools, see the Printing Guide and the Job 
Management Guide.

Setting up Fiery WebTools
In order for network users to access and use the Fiery WebTools, you need to set 
certain Fiery ZX Setup options in Network Setup and Printer Setup. You also need to 
prepare each user’s workstation to communicate with the Fiery ZX over the Internet or 
intranet.

TO SET UP FIERY WEBTOOLS ON THE FIERY ZX:

1. In Network Setup>Port Setup>Ethernet Setup, set “Enable Ethernet” to Yes.

2. In Network Setup>Protocol Setup>TCP/IP Setup>Ethernet Setup, set “Enable TCP/IP 
for Ethernet” to Yes, and set a valid, unique IP Address for the Fiery ZX.

3. In Network Setup>Service Setup>Web Services Setup, set “Enable Web Services” to 
Yes.

4. Exit Network Setup, and select Yes at the Save Changes screen.

5. In Printer Setup, set “Publish Print Queue” to Yes.

6. Exit Printer Setup, and select Yes at the Save Changes screen.

Downloading 
installers with 
Fiery WebTools 
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TO SET UP THE FIERY WEBTOOLS ON EACH USER’S WORKSTATION:

1. Enable TCP/IP networking.

2. Make sure the workstation has a valid, unique IP address.

3. Make sure the workstation is installed with one of the following Internet browsers:

• Windows 95 and Windows NT—Either Netscape Communicator v4.0.3 or Microsoft 
Internet Explorer v3.0.2

• Mac OS—Netscape Communicator v4.0.3

NOTE: Netscape and Microsoft continue to release frequent updates to their browsers. 
As support cannot be guaranteed for all versions, use the versions specified above for 
best results.

4. Make sure Java is enabled in your Internet browser.

For more information on setting up the Fiery ZX and your network, see the 
Configuration Guide. 

Using the Installer WebTool
The Installer WebTool duplicates the printer file installers on the User Software CD, 
allowing you to easily download the current version of printer files from the Fiery ZX 
to your workstation.

TO DOWNLOAD PRINTER FILES INSTALLERS

1. Launch your browser application and enter the DNS name or IP address of the Fiery ZX.

2. Select a login level, enter a password if necessary, and click OK.

No password is required to log in as Guest. You have full access to the Installer 
WebTool when logged in as Guest.
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3. Click the Installer button.

The Installer WebTool appears.

4. Under the name of your operating system, click “Printer Files”.

For Windows computers, a dialog box appears, prompting you to save the file 
“Prntdrve.exe” to the location you choose.

For Mac OS computers, a folder named “Printer Driver” is downloaded to the desktop 
in a BinHex-encoded, compressed format. If your internet browser is equipped with an 
expander utility such as StuffIt Expander™, the folder will be decoded and 
decompressed automatically.

5. For Windows computers, browse to the location where you want to save the 
Prntdrve.exe file and click Save.

For Mac OS computers, if the Printer Driver folder was not automatically decoded and 
decompressed, launch a utility that will perform that function.

6. For Windows computers, double-click the Prntdrve.exe file, browse to the location 
where you want to install the Prntdrv folder, and click Next.

The Prntdrv folder is installed to the location you specified.
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7. Install the appropriate printer driver for your operating system.

For instructions on installing the printer driver for Windows 95, see “Setting up 
printing with Windows 95” on page 2.

For Windows 3.1x, see “Setting up printing with Windows 3.1x” on page 17.

For Windows NT 4.0, see “Setting up printing with Windows NT 4.0” on page 21.

For Mac OS computers, see “Installing printer files” on page 47.
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This chapter provides troubleshooting tips.

On a Windows computer

Setting up IPX (Novell) printing for Windows NT 4.0
If you have problems installing the Fiery ZX with Windows NT, try installing another 
PostScript printer (such as the Apple LaserWriter IIg), and then install the Fiery ZX. 
Installing another printer insures that all files are properly installed and available. For 
instructions, see your Windows NT documentation.

Installing the Adobe PostScript Printer Driver
If you are reinstalling the Adobe PostScript Printer Driver, delete any previous versions 
and related files before installing. Search for and delete all files named Efax*.* in the 
Windows\System folder and the Windows\System\Color folder. See the Adobe 
README file included with the printer driver for more information.

Problems connecting with the Fiery Downloader or 
Command WorkStation

1. If you are using the Fiery Downloader with Windows 95, make sure that IPX/SPX and 
TCP/IP networking protocols are both enabled. 

See “Completing the Windows 95 IPX/SPX or IPX (Novell) connection” on page 10.

2. Make sure that the connection to the Fiery ZX is configured correctly.

To check the current configuration, launch the utility, (for Fiery Downloader only, 
choose Open from the File menu), select the Fiery ZX entry in the Choose Printer 
Device window, and click Modify to see current settings. If the settings are incorrect, 
you can change them in this dialog box.

On a Mac OS computer

Setting up the Fiery ZX in the Chooser
If auto-setup does not work and you are prompted to select the PPD, select the 
Fiery ZX file in your System Folder:Extensions:Printer Descriptions folder.

Troubleshooting
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Installing PostScript screen fonts
If you experience problems installing the PostScript screen fonts from the User 
Software CD to the System Folder:Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts”.

This folder must be located outside of the System Folder.

3. Move fonts that you are not using from the System Folder:Fonts folder to the 
Uninstalled Fonts folder.

4. Continue to copy fonts from the User Software CD to the System Folder:Fonts folder.

5. Create an alias to the System Folder:Fonts folder and to the Uninstalled Fonts folder.

6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and relaunch them in order to 
view and use the newly installed fonts.

Alternately, you can try combining fonts from multiple suitcases into a single suitcase.
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for Macintosh applications 53

Printer Driver folder on User 
Software CD 48
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Windows NT printer drivers

printer ports
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WebTools, see Fiery WebTools
Windows

troubleshooting 63
Windows 3.1x

Adobe PostScript printer driver 17
PostScript printer driver 17 to 21
printing 17 to 21

Windows 95
parallel port 7
PostScript printer driver 3, 5
SMB printing 13 to 16
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